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The assessment material and marking scheme in this Coursework pack can be used by staff in 
approved SQA centres for the purposes of assessment of candidates in accordance with the 
Course Assessment Specification.  The pack must not be released to candidates or distributed 
for other purposes.  SQA distributes these materials only to centres;  these materials are not 
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The information in this publication may be reproduced to support SQA qualifications.  If it is to be 
used for any other purposes written permission must be obtained from the Publications Officer at the 
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Where the publication includes materials from sources other than SQA (secondary copyright), this 
material should only be reproduced for the purposes of examination or assessment.  If it needs to be 
reproduced for any other purpose it is the centre’s responsibility to obtain the necessary copyright 
clearance.  The SQA’s NQ Delivery:  Exam Operations’ Team at Dalkeith may be able to direct you 
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This publication must not be reproduced for commercial or trade purposes.  This material is for use 
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Organisation and Conditions for Assessment 
 
 
The assessment is designed to test each candidate’s ability to apply knowledge and understanding and 
practical skills, developed through study of the Database Systems and Using Information Units.  The 
mark out of 30 should be submitted to the SQA unscaled.  This will be combined with the 
examination mark out of 70 to establish the candidate’s overall grade of award.  This mark should 
also be used in preparation of estimate grades. 
 
The notional design length for the assessment is 8 - 10 hours.  However, a candidate may be allowed 
longer than this if required.  
 
The assessment is to be undertaken under “open book” conditions, but under supervision by the tutor 
to ensure that the work submitted is the candidate’s own work.  The tutor may give the candidate 
hints and/or help if requested.  Any such help should be reflected in the marks awarded.  Once the 
task has been completed and marked, it should not be returned to the candidate for further work. 
 
These instructions are designed to be used in conjunction with the data files provided with the 
electronic distribution of the task.  These can be downloaded from the SQA secure website. 
 
The files to be downloaded should include : 

• The 2010/2011 Intermediate 2 Information Systems Coursework Task  
• FunFitDB database 
• FunFitDB Task 5-8 database 
• Early bird discount spreadsheet 
• Renewal Letter for mail merge 
• FunFitnessLogo graphic 

 
Candidates are not required to spend time entering data into a database.  Instead, the data should be 
prepared beforehand and provided to candidates by the centre. 
 
To facilitate this, database files for Microsoft Access and FileMaker Pro have been provided for this 
task.  The files contain or represent a number of tables with data entered.  The appropriate file(s) 
should be made available to the candidates. 
 
Centres using alternative relational database software can use the accompanying data files, which 
contain tab-delimited data required for the tables.  The centre should set up tables as appropriate 
within the database software and import the data provided.  The resulting database file should then be 
made available to the candidates. 
 
Two versions of a database are being supplied this year.  It is essential that candidates are 
issued with the correct version at the appropriate times.  They must not be given access to the 
second version until they have submitted answers to prior tasks. 
 
Candidates should be given a copy of the marking grid before starting the task so that they are aware 
of the mark distribution for each part. 
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Special Arrangements for Intermediate 2 Coursework 2010-2011 
 
Centres are asked to pay special attention to the following arrangements.  
 

• Candidates are not required to spend time entering data into a database. Instead, the data 
should be prepared beforehand and provided to candidates by the centre.  To facilitate this, 
Microsoft Access (2003 format) and Filemaker (v.7) files as well as a text (tab) delimited file 
have been provided.  Centres using other systems will require to create both versions of the 
database from the tab separated file provided. This file can also be used if centres encounter 
any difficulties with the supplied Access or Filemaker databases.  
 

• In a change from previous years, two versions of the database have been included.  The first 
database contains the Membership table of the system.  Candidates will be required to 
create the Centre table from the data dictionary and then set up the relationships between the 
two tables. Candidates will be required to submit a printout of the Documenter (or equivalent 
screen shots) of the Centre table only as evidence for Task 3.  Evidence for Task 4 should 
also be generated from this version of the database. 

 
• Task 3 asks candidates to print out a copy of the design of the Centre table. This is to provide 

evidence that the correct field types have been used and all necessary validation checks 
implemented. The assessor should help candidates produce this printout without penalty.  

 
• Task 4 asks candidates to print out a copy of the relationship between the tables. The assessor 

should help candidates produce this printout without penalty. 
 

• Candidates will not use their database structures to complete Tasks 5-8. Instead, centres 
should issue candidates with the second, fully populated database.  
 

• The second database is a complete implementation of the system. This working database 
should be issued to candidates after Task 4 has been submitted. Candidates must use this 
working database to complete Tasks 5-8.  
  

• Additional notes follow which detail how candidate evidence is to be generated.  
 

o In FileMaker Pro, to get a printout of the design, candidates should adhere to the 
following instructions. 

(1) Select the “Define” option from the File menu and then select the “Database” 
option from the sub-menu. 

(2) Click on the Tables tab. 
(3) Highlight both tables by clicking on the name of the first table then holding 

down the shift key and clicking on the other table. 
(4) Click on the Print button. 

 
o In MS Access, to get a printout of the design, candidates should adhere to the 

following instructions.   
(1) Select the “Analyze” option from the Tools menu and then select the 

“Documenter” option from the sub-menu. 
(2) Select the table(s) required and then click Options button. 
(3) Make sure that the following options are checked/selected: 
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• Include for Table 
 Properties 
 Relationships 
• Include for Fields 
 Names, Data Types, Sizes 

and Properties 
• Include for Indexes 
 Names and Fields 
 

(4) Click on OK 
(5) The required table design is 

displayed on screen and can be 
printed. 

 
 

o Printing Relationships in FileMaker 8. 
(1) Select the “Define” option from the File menu and then select the “Database” 

option from the sub-menu. 
(2) Click on the Relationships tab then click on the Print button. 

 
o Printing Relationships in Access 

(1) Open the Relationships window. 
(2) Select the “Print Relationships” option from the File menu. 

 
Alternatively, screendumps of the evidence would also be acceptable. 
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Intermediate 2 Information Systems  
Coursework Task 2010/2011 
 
 
Fun & Fitness run a number of sports clubs such as swimming pools, astroturf, fitness gyms and 
leisure centres.  Members of the public can join each sports club by buying an annual membership.  
After joining, each member can use the facilities or attend classes run in the club for no extra charge.  
In some clubs, personal trainers are available. 
 
Fun & Fitness store details about members of each sports club in a database. 
 
A sample record is shown below. 
 
Membership number GDA149 
Firstname Jessica 
Surname Olson 
Address 82 Vel Street 
Town Allentown 
Postcode J0 5QW 
Date of birth 24/06/1954 
Month of renewal October 
Gender F 
Type of membership Adult 
Club ref SP324 
 
Fun & Fitness decide to add the following information about each sports club to the database. 
 

Field Name Field Type Field Size Primary Key Sample Data 
Club ref Text 5 Yes SP433 
Club name Text 25 No Waves 
Location Text 25 No Brockton 
Club type Text 15 No swimming pool 
Date opened Date  No 12/04/1998 
Personal trainer Boolean  No No 
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Your teacher/lecturer will provide you with the database file FunFitDB.  You must use this version 
to complete Tasks 1-4. 
 
What you have to do  
 

 Tasks Evidence Required 
1  Open the file called FunFitDB. 

 
(Using a relational database application, add a new table called 
Centre that can be used to store information about each sports 
club run by Fun & Fitness.  You should use the design shown on 
the previous page. 
 

 

2  There are four types of sports clubs ─ gym, astroturf, swimming 
pool, leisure centre.  Alter your table design so that the Club 
type field has a restricted choice validation check set to allow 
only these four options to be entered. 
 

 
 

3  Print out a copy of your design for the Centre table.  This should 
show the field types, field sizes and validation checks. 
 

Printout of the Centre 
table design showing 
field types, field sizes 
and validation checks. 

4  Link the Centre table to the Membership table by using the 
Club ref field. 
 
Print out a copy of the relationship showing the link between the 
tables. 
 

Printout/screendump of 
the relationship window 
showing the link between 
the two tables. 

 
 
You must now submit Tasks 1-4 to your teacher/lecturer 
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Your teacher/lecturer will provide you with the database file FunFitDB Task 5 -8.  You must use 
this version to complete tasks 5, 6, 7 and 8 
 
What you have to do (continued) 
 

 Tasks Evidence Required 
5 Create a simple report/layout to display the entire contents of the 

Centre table. 
 
Produce a one page printout using this report/layout ensuring 
that all fieldnames and data can be clearly seen. 
 
Your name must be included in the report as a header or 
footer. 

Printout of the Centre 
table report/layout. 

6  Produce a printout of a report/layout showing members of sports 
clubs which are leisure centres whose membership is due for 
renewal in September. 
 
The printout should display the following fields: 
Membership number, Firstname, Surname, Address, Town, 
Postcode, Club name, Club type, Type of membership and 
Month of renewal. 
 
Save your work as Task 6. 
 

Printout of all leisure 
centre members whose 
membership is due in 
September in a 
report/layout as 
specified. 

7  A special discount promotion is to be offered to Student and 
Adult members of gyms with a personal trainer. 
 
Produce a printout of a report/layout showing Adult and Student 
members of the gyms with a personal trainer. 
 
The printout should display only the following fields: 
Firstname, Surname, Type of membership and Club name. 
 
Save your work as Task 7. 
 

Printout of all adult and 
student members of gyms 
with personal trainer 
available in a 
report/layout as 
specified. 

8  Special female only training sessions are to be offered for 
swimming pool members. 
 
Produce a printout of a report/layout showing all female 
swimming pool members.  The report data should be listed in 
alphabetical order of club name.  If a swimming pool has two or 
more members they should be listed in alphabetical order of 
member surname. 
 
The printout should display only the following fields: 
Club name, Firstname and Surname. 
 
Save your work as Task 8 
 

Sorted printout of all 
female swimming pool 
members in a 
report/layout as 
specified. 

 
Collect all printouts in the order they were asked for.  Ensure your name and task number is 
printed on each report before handing to your teacher/lecturer. 



Scottish Qualifications Authority   12 
Coursework Task 
Intermediate 2 Information Systems  2010/2011 

Fun & Fitness have decided to offer discounts to people who renew their membership promptly.  The 
manager asks you to update the spreadsheet displaying the annual membership fees and the early bird 
discount. 

 

 
 

What you have to do (continued): 
 
 

 Tasks Evidence Required 
9 Note:  Your teacher/lecturer will provide you with the file Early 

Bird Discount containing the spreadsheet data. 
 
Open the file called Early Bird Discount. 
 
If the Annual Membership Fee is £50 or more, then a 15% 
discount is given, otherwise 10% discount is given. 
 
Enter a suitable formula in column C to automatically calculate 
the Early Bird Discount. 
 

 

10 Format the spreadsheet as shown above. 
 
Save your work as Task 10. 
 

 

11 Print two copies of your spreadsheet ─ one showing the answers 
and another showing the formula used. 
 
Your name must be included on each printout. 
 

Two printouts of 
spreadsheet ─ one 
showing answers and one 
showing formulas. 

  
 



Scottish Qualifications Authority   13 
Coursework Task 
Intermediate 2 Information Systems  2010/2011 

The manager of Fun & Fitness asks you to prepare a letter to be sent to all the leisure centre members 
whose membership is due in September. 
 
Before completing the following tasks, make sure you have the following: 
 

• File called renewal letter containing the text for the letter 
• Results from the query in Task 6 
• Table of membership fees from Task 10 
• File called FunFitnessLogo 
• Copy of Appendix 1 

 
Look at Appendix 1. 
It contains the standard letter to be used to send to members about their membership renewal. 
 
The renewal letter should be personalised using the data from the database.  The highlighted items 
should be replaced with data from the database query you created during Task 6. 
 
The letter includes the table of membership fees you completed in Task 10. 
 
The file containing the company logo is to be included in the letter heading. 
 
What you have to do (continued) 
 

 Tasks Evidence Required 
12 Open the file called renewal letter. 

 
Insert placeholders in the places shown for the personal 
information held in the database about leisure centre members 
whose membership is due in September. 
 

 

13 Create the letter heading as shown in Appendix 1 by 
• Inserting the logo supplied into the correct place and 

typing the company name and address. 
• Formatting the company name and address using a 

similar font, size and style. 
• Adding a border around the letter heading. 

 

 

14 Add the table of membership rates you completed in Task 10 
into the letter in the appropriate place. 
 

 

15 Complete the blank standard letter by 
• Formatting the letter using similar size, style, font and 

alignment as shown in Appendix 1. 
• Inserting your name at the bottom of the letter where 

indicated. 
 

Save as Task 15 
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16 Print the completed letter showing the placeholders. Printout of blank 

standard letter. 
17 Merge the renewal letter with the database query you created 

during Task 6 and print the personalised letters. 
Printout of personalised 
letters for each leisure 
centre membership due 
for renewal in 
September. 
 

 
(30 marks) 

 
Collect all printouts in the order they were asked for.  Ensure your name and task number is on 
each printout before handing to your teacher/lecturer. 
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 Fun & Fitness 
 Head Office 
 Ace Road 
 Lowhall 

Appendix 1 
 
 
 
 
 
 
 
 
 
 
 
Date :  15 August 2010 
 
Sylvia Duffy 
75 Vitae Street 
Lowhall 
EB3 3ZM 
 

Membership Reference Number:  QF1203 
 
Dear Sylvia, 
 
It has been great having you as a member of Waves over the last year.  We hope that you have 
enjoyed your membership and are enjoying the benefits of a healthier lifestyle. 
 
As you are probably aware, your Senior membership is due to expire in May.  If you renew your 
membership before the beginning of the month you are entitled to our Early Bird Discount. 
 
The annual membership fees are outlined below. 
 
Type of Membership Annual Membership Fee Early Bird Discount 
Adult  £100.00  £15.00 
Senior  £30.00  £3.00 
Student  £50.00  £7.50 
Child  £15.00  £1.50 
 
Please complete the membership renewal form and hand it in with your payment the next time you 
visit Waves. 
 
Remember, it is important that you continue to train regularly in order to achieve your fitness goals. 
 
Regards, 
 
 
 
 
(your name in here) 
Fun and Fitness. 
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Marking Grid 
 
Name    Date    
 

Topic Possible 
Marks 

Marks 
Gained Comment 

Task 1─4 Creation of 
Centre Table 

Creation of table 3,2,1,0   
Restricted choice 1,0   
Link centre and 
membership tables 1,0   

 
Task 5 Report Report/Layout printed 1,0   
 

Task 6 Search 
Correct search 1,0   
Report/Layout printed 1,0   

 

Task 7 Search 
Correct search 2,1,0   

Report/Layout printed 1,0   
 

Task 8 Search and 
Sort 

Search correct 1,0   

Sort correct 2,1,0   
Report/Layout printed 1,0   

 

Tasks 9─11 Spreadsheet 
Calculate discount 3,2,1,0   

Format spreadsheet 2,1,0   
Print 1,0   

 

Tasks 12─17 Personalised 
Letters 

Add placeholders 1,0   
Create and format 
letter heading 3,2,1,0   

Insert table 1,0   
Format letter 2,1,0   
Merge letters 2,1,0   

 
 Overall Total  30   
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CONFIDENTIAL – not to be issued to candidates 
Detailed Marking Guidelines 
 
The following guidelines assume that all work was carried out by the candidate on their own (or with 
the assistance of open book materials).  Any assistance by the assessor should be reflected in a 
reduction of the number of marks awarded. 
 

Creation of 
Centre Table 

Creation of table 3,2,1,0 Accurate creation of 
• table fields (1 mark) 
• field types (1 mark) 
• field sizes (1 mark) 

as specified without any help 
Restricted choice 1,0 Club type set to restricted choice ─ only 

astroturf, gym, leisure centre, swimming pool 
values accepted. 

Link centre and 
membership tables 

1,0 Tables linked without teacher help using club 
ref ─ 1 mark 

 

Report 

Report/Layout printed 1,0 • A one page report created/printed 
without help.   

• All field names should be clearly visible. 
• Candidate name included in 

header/footer. 

 

Search 

Correct search 1,0 Complex search for  
• leisure centre members 
• renewal due in September. 

Report/Layout printed 1,0 Membership number, Firstname, Surname, 
Address, Town, Postcode, Club name, Club 
type, Type of membership and Month of 
renewal fields included and clearly visible. 

 

Search 

Correct search  2,1,0 Complex search for  
• Adult or Student members 
• gym 
• with personal trainer. 

Report/Layout printed 1,0 Firstname, Surname, Type of membership and 
Club name fields included and clearly visible.  
(No penalty for including Type of 
membership, Club type and/or Personal 
trainer) 

 

Search and 
Sort 

Search correct 1,0 Complex search for  
• Female members 
• swimming pool. 

Sort correct 2,1,0 Complex sort (2 marks) 
• club name ascending 
• and surname ascending 

Simple sort ─ 1 mark 
Otherwise ─ 0 mark 

Report/Layout printed 1,0 Club name, Firstname, Surname fields 
included and clearly visible. 
(No penalty for including Gender and/or Club 
type) 
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Spreadsheet 

Calculate discount 3,2,1,0 =IF(B2>=50,15%*B2,10%*B2) 
Replicated down column correctly. 
Correct condition ─ 1 mark 
Correct TRUE calculation ─ 1 mark 
Correct FALSE calculation ─1 mark 
 
Other correct formulas acceptable  
Such as  
=(B2<50,10%*B2,15%*B2) 
=(B2>=50,0.15*B2,0.10*B2) 

Format spreadsheet 2,1,0 Correct formatting 
(left alignment in column A, centre alignment 
in column B&C, currency with 2dp in column 
B&C ) ─ 1 mark 
Correct shading and text colour in row 1 ─ 1 
mark 

Print 2 versions 1,0 One printed version showing answers to 
formula calculation and one printed version 
showing formula used all visible ─1 mark 

 

Personalised 
Letters 
 
 

Add placeholders 1,0 Insert field place holders in appropriate 
locations in letter ─ 1 mark 
More than one omitted or more than one error 
─0 marks 

Create and Format 
Letter Heading 

3,2,1,0 • Suitable font, style, size, alignment ─ 
1 mark 

• Add border around heading ─ 1 mark 
• Insert logo file and applied 

appropriate text wrap ─ 1 mark 
Insert table 1,0 Inserted /Copy & paste spreadsheet table ─ 1 

mark 
Format Letter 2,1,0 Suitable font, style, size, alignment 

• Any suitable font 
• 12/14 point size 
• Date/address/ref no ─ bold style 
• Body text fully justified 

3 or 4 bullet points correct ─ 1 mark 
• Spaces at placeholders correct and 

own candidate name as sender ─ 1 
mark 

Personalised Letters 2,1,0 Prints personalised letters 
• Correct data source ─ uses correct 

query results from Task 6 ─ 1 mark 
• Print merge letters to 3 members 

listed in report from Task 6 ─ 1 mark 
Total Marks 30  
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Results 
 
Task 5 
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Task 6:  3 records 

 
OR 
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Task 7: 20 records 
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Task 8:  24 records 
 

 
Task 11 
Spreadsheet with answers calculated 
 

 
 
Spreadsheet with formula showing 
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Task 12:  placeholders (printed at task 15) 
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Task 13-17 
Three personalised letters 
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